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Important Information 
 
This document could include technical inaccuracies or typographical errors.  
Changes are periodically made to the information herein; these changes will be 
incorporated in new editions of the publication.  The Office of Materials and 
Research (or the Georgia Department of Transportation) may make changes in the 
processes described in this document at any time. 
 

Notice 
 
The Office of Materials and Research (or the Georgia Department of 
Transportation) assumes no responsibility for any technical inaccuracies or 
typographical errors that may be contained herein.  In no event will the Georgia 
Department of Transportation be held responsible for direct, indirect, special, 
incidental, consequential or any other loss or damage caused by errors, omissions, 
misprints, misinterpretation of the information found in this document, even if 
advised of the possibility of such damages.  The Georgia Department of 
Transportation expressly disclaims any and all liability to any person, in respect 
of anything done or omitted, and the consequences of anything done or omitted, 
by any such person in reliance on the contents of the publication. 
 

All Rights Reserved 
 
No part of this document by be reproduced, reformatted, or transmitted in any 
form by any means, electronic or mechanical, including photocopying, recording 
or through any information storage and retrieval system, currently available or 
developed in the future, without prior written approval by the Georgia Department 
of Transportation.   



Revision Date 3/11/2008                             iii 

Important Information for Users 
The following table provides logon ids and passwords necessary for your 
participation in the FDCS 4.2 User class: 
 
User Names and Passwords 
Version User Type User Information Needed 
Webview Student Id – training123 

Password – pass  
Note - the id and password are case 
sensitive 

Server All Id – your network id 
Password – your network password 

Client Student Id – train 
Password – train 
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1 Overview of FDCS 
This computer program is used by GDOT Testing Technicians and Contractor Testing 
Technicians to collect & distribute field test data. It is designed to be a standalone system 
(Client) that can be used in remote locations to collect field test data for future 
distribution to a central database (Server). 
It is composed of a collection of field test data forms that are used to collect, distribute 
and report field material test data.  This includes Roadway & Plant, Independent 
Assurance, Aggregates, and Portland Cement. 
 

1.1 Changes in FDCS 4.2 
The following are changes since version 4.1: 
Client Side: 
• Asphalt Reports re-written 
• Aggregate Material Code Update 
• 128C Source re-assigned 
Server Side: 
• Migrated data to SQL database 
• Consolidated FDCS system to a single database (no copies) 

o Removed all batch jobs 
• Update web upload 
1.2 Functionality 
The FDCS performs multiple functions: 
• Initial calculations on test data. 
• Backs up or restores data. 
• Exchanges data between technicians. Some tests are multi-part, which are 

started by one technician and completed by another, which means two 
different computers have to talk to each other. Computer diskettes or e-mail 
attachments are the recommended media to use to exchange test data between 
technicians and at remote locations.  

• Generates hardcopy test reports and statistical summaries and quality ratings, 
including built-in calculations.  

• Allows the user to edit, review, or delete test data. 
• Uploads test data to GDOT. 
• For aggregate or cement producers, imports test data from their own system to 

FDCS using templates. 
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• Allows the user to import updated nuclear gauge factors to the Client after the 
gauges are calibrated. 

1.3 New FDCS 4.2 Architecture 
The system architecture has changed since the last version of FDCS.  The main 
change has been the elimination of the batch process, which has been replaced 
with a more streamlined exchange of Client-Server data.  The new architecture 
includes the following process: 
1. FDCS Client Uploads data through the firewall to the central SQL Server 

database. 
2. GDOT users through the network access the central database on SQL Server 

through Terminal Services using Production or Read-only user interfaces.  
3. External users view their own data via a secure web connection. 

 

 
FIGURE 1.  NEW FDCS SYSTEM ARCHITECTURE 

1.4 Target Audience 
This course is designed for the following GDOT personnel and Producer 
Personnel: 
• Testing Management 
• Independent Assurance 
• Technical Services Branches 
• Contractor or producer Quality Control personnel at Asphalt plant 
• Aggregate sources 
• Cement Mills 
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1.5 Course Prerequisites 
• Basic Windows skills 
• Knowledge of Quality Control or Acceptance Testing equipment & 

procedures 
1.6 Course Objectives 
In order to successfully complete this course, you will complete the following 
tasks: 
• Download FDCS 
• Navigate in FDCS 
• Input Data 
• Upload data 
• Print Reports 
• Backup and Restore Data 
• View Data 
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2 Installing FDCS 4.2 
2.1 Overview 
The software is available for installation in several ways: 
• Installing from an Internet download 
• Installing from a CD-ROM 
Additional technical information regarding the operation of this program can be 
found on the CD-ROM in the DOCS folder. If you did not receive this program 
on CD-ROM then they can be downloaded from the Internet at 
http://tomcat2.dot.state.ga.us/fdcs/upgrade/fdcsupgrade2.cfm. 
2.2 System Requirements 
For the best results you should have at least a Microsoft Windows 98 or higher 
(Windows NT 4 needs service pack 4 or later). This program requires:  
• Access to the Internet (any Internet Service Provider or GDOT Network 

connection) 
• Windows 98 or above * 
• Internet Explorer 5.0 or above 
• 40 MB of hard disk 
• 64 MB of ram (256 MB recommended) 
• 166 MHZ CPU clock (500 MHZ recommended) 
• May need administrator profile to perform installation ** 
 
* This application is not supported on the Windows 95 operating system. If you 
are experiencing problems installing FDCS 4.x on Windows 95, please contact 
your local technical support. 
**If this software is to be installed on a computer that belongs to your company, 
you must contact your computer systems administrator and get permission to 
install it or have them install it for you. Your administrator will also need to make 
sure that you have write permissions to the GDOTDCS.MDE file. 
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2.3 Installation Instructions for FDCS 4.2 
This chapter provides an overview on how to install the latest version of FDCS.  
Download the correct update by clicking the link at 
http://tomcat2.dot.state.ga.us/fdcs/upgrade/fdcsupgrade2.cfm. 
See the installation instructions under the Help button for each type of 
installation. 

  
2.4 Light Upgrade - Future Updates of Version 4.x 
You can find links to the latest version of the GDOT Field Data Collection 
System and related documents at: 
http://www.dot.state.ga.us/dot/construction/materials-research/software.shtml   
You must keep your copy of FDCS software up-to-date. GDOT does not support 
older versions of this software. Attempting to Upload with an unsupported version 
will result in an error message directing the user to the FDCS Update webpage. 
2.5 New Installation of the Field Data Collection System 
If the technician’s computer does not have any previous version of FDCS, use the 
Full Install. 
2.6 Contacting GDOT for support 
You may contact the GDOT IT Division Solutions Center for assistance with this 
software, using the Support Request form on the OMR Software webpage: 
http://www.dot.state.ga.us/dot/construction/materials-research/downloads/fdcs-
index.shtml 
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However, before you do please check the following things: 
1. Check for a new version of this software. If you have run in to a problem with 

the program, it may have already been fixed in the latest version. Additionally 
the Solutions Center only provides support for current version of FDCS. 

2. Do one of the following: 
• Write down any error messages.  Do not paraphrase them. Write them 

down exactly as they appear on your computer's screen.  
• Make a screen shot of the error message(s). Include any error messages or 

screen shots with the Support Request. 
3. If you have not already done so, read this manual; specifically the 

Troubleshooting chapter. Most usage problems can be answered by reading 
the manual.  

4. Be at your computer when contacted by the GDOT IT Division Solutions 
Center. You may be asked to do things to your computer while talking to 
them.  

 
The phone number for the GDOT IT Division Solutions Center is 404-651-5010. 
The first available Operator will take your call. 
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3 Introduction to FDCS Version 4.2 
This chapter briefly describes the Field Data Collection Software test forms and 
documents the flow of test data from the field project sites to the Office of Materials and 
Research database server.  
 

3.1 Terminology 
The following terms are used through out this document: 
Term Description 
FDCS Abbreviation for the Field Data Collection System. 
Client The edition of FDCS on the technician’s computer. The 

data collected in this edition should be uploaded to the 
Server version and can be used to generate local reports. 

Server The central database collection of uploaded test data. The 
data can be verified and used for various reports on a 
statewide basis. 

Field When referring to data entry, a single piece of information, 
such as a measurement or a description. 

Record A group of fields that describe one entity. In this application 
the entity is usually a sample taken for testing. 

Key fields Each record must contain a field or a set of fields that 
uniquely identifies it. This prevents duplicates and enables 
searching.  These special fields are called key fields. 

Filter The process used to show you a specified selection of your 
records or just one record rather than all records at once. 

Form View A window containing the contents of one or more test 
records that you may view, edit, or add to.  A printed test 
record is often called a “report.” 

Datasheet 
View 

A table format displaying the same records shown in Form 
View. 

Web View The secure internet link for Producers to view their own 
uploaded records in the central database. 

Report A record or group of records, or calculation obtained from 
one or more records, specially formatted for printing. 

Upload The process of electronically sending data to the GDOT 
using the Field Data Collection System. 

Import The process of adding data to the system from a source other 
than your default directory. 

Backup The process used to save data to another location the event 
of a system failure. 

Restore The process of adding backed up data to your default system.  
This is done if the data on your default system was corrupted 
or lost. 
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3.2 Using the Field Data Collection System 
This chapter provides brief introduction to the Field Data Collection System 
(FDCS) main menu options and describes the additional options available within 
the software. It also provides a brief introduction to the windows functions within 
the software and how to navigate within the FDCS using these functions. 

 
3.3 Getting Started with FDCS 
You can start the application in two ways: 
• From the Desktop 
• From the Program Menu 

 
3.3.1 Starting from the Desktop 

When the Field Data Collection System software installs on your 
computer, it automatically creates a shortcut on your Desktop. 
Follow the steps below to start the application from your Desktop: 
1. Locate the Field Data Collection System icon. 

 2. Double-click to start the application. 
 

3.3.2 Starting from the Programs Menu 
You also have the option to start the Field Data Collection System 
software from the Windows Program menu. 
Follow the steps below to start the software from the Program menu: 

  
1. From your desktop menu, click Start. 
2. Select Programs>Field Data Collection System. 
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3.4 Navigating the Main Menu 
When you start FDCS, the first thing you will see is the Main Menu. The Main 
Menu provides a “pallet” of entry forms and utilities for each testing group that 
uses this application. Click on the tab with the name of your testing group to see 
the forms and reports.  
 

 
 

1. Click on the first tab for Roadway + Plant. Note the test forms, reports, and 
reference updates on this panel. 

 

  
2. Click the fourth tab for Concrete. Note the different test forms, reports and 

reference updates on this panel. 
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3.5 Other buttons on the Main Menu 
 

Button Description 
Check for 
updates on the 
GDOT web site 

Clicking this button opens your default web browser and 
takes you to the GDOT FDCS download web page. (This 
requires an Internet connection). You should check this page 
regularly. 

Upload Data to 
GDOT 

Click this button to start the process of sending entered and 
modified data to the GDOT electronically. 

Backup/Restore 
4x Data 

Clicking this button will open the backup/restore window that 
enables you to make a copy of your data on floppy disk or re-
load data from a diskette. 

Restore 3.31 
Data 

Click this button to reload data from a diskette. 

FDCS User 
Manual 

Click this button to open the FDCS User Manual, which 
includes a detailed description of each function and form. 

OMR Training 
Manual 

Clicking this button opens this Training Guide.  

 
The following test forms are available: (depending on which testing group tab you 
selected) 

 
Form Number Roadway and Plant Group Test Forms (English and Metric Units) 
DOT159 Asphaltic Concrete Lot Worksheet entry form.  
DOT176 Thickness Measurement entry form  
DOT553 Roadway Compaction form 
DOT150 Control Strip and Asphaltic Compaction data entry form 
DOT152 Water Turbidity entry form 
DOT152 Asphaltic Concrete Comparison / Referee entry form 
DOT161 Asphaltic Concrete Quality Entry form 
DOT160 Asphaltic Concrete Comparison/Referee 
Form Number Independent Assurance Group Test Forms (English and Metric Units) 
DOT176 Thickness Measurement entry form  
DOT553 Roadway Compaction form  
DOT386 Asphaltic Comparison Compaction / Void data entry form  
DOT168 Concrete Quality Comparison data entry form 
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DOT163 Field Paint Thickness data entry form 
DOT162 Bridge Painting Conditions data entry form 
DOT165 Galvanized Coating data entry form 
DOT116 Pipe Certification and Quality data entry form 
DOT150 Control Strip and Asphaltic Compaction data entry form  
DOT160 Asphaltic Concrete Comparison / Referee entry form 
DOT169 Miscellaneous data entry form 
Form Number Aggregate Group Test Forms (English and Metric Units) 
DOT 640 Aggregate Producer Quality data entry form 
DOT 641 Aggregate Producer Quantify data entry form 
 Import Custom AGG Files - This is a special function for Aggregate 

producers who use their own custom software for data collection. It 
enables them to automatically import data from their system and send it 
to the GDOT. 

Form Number Portland Cement Group Test Forms (English and Metric Units) 
OMR-049 Portland Cement data entry form 
 Import Custom Cement Files.  This is a special function Portland Cement 

Producers who use their own custom software for data collection. It 
enables them to automatically import data from their system and send it 
to the GDOT. 

 
Other options provided by the software include the following: 
 
Options Description 
Asphalt Reports Click this button to open the Asphalt Reports window.  This 

has options for generating printed statistical reports relating to 
the DOT 159 Asphaltic Concrete Lot Worksheet. 

Aggregate Reports Clicking this button will open the Aggregate Reports dialog 
box, which contains options for generating printed statistical 
reports relating to the DOT 640 and DOT 641 reports. 

Materials Summary 
Report 

A summary report can be created for each form that does not 
have a specified report. 

Edit Gauge Factors Clicking this button will show you the gauge factors used for 
the DOT 553 Roadway Compaction form. You may also edit 
them if necessary, but usually you will use the “Update Gauge 
Factors” to get the correct factors. 

Update Gauge Factors Clicking this button will update the list of gauge factors with 
one provided on an update disk. 
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Options Description 
Random Number 
Sampling Utility 

Users of the 159 forms use this to determine which loads in a 
lot are randomly sampled. 

Generic Random 
Number Generator 

This utility is a general-purpose random number generator for 
tests that use random sampling. 
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4 Opening a Form for Data Entry 
Each form has fields that are unique to the test type. For this training example, we will use 
the DOT 159 on the Roadway + Plant tab. 
1. Click on the button for DOT 159 (English). 
 

 
 
2. The DOT 159 Create/ Edit window opens.  

 
3. Enter the Header information: 
• Plant No.: 123 
• Project ID: STP-123(11)01 
• Type Mix: 19mm 
• Level: A 
• Lot No.: 01 
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Note:  All information shown in the header key fields is required to create new records. 
 

Header Field Description 
Plant Number An Asphalt Plant Number is the designation assigned by the 

DOT to asphalt producers that supply material to the DOT. The 
Source Plant Number entered must be the number of the plant 
producing the mix. This is a numeric field. Only numbers may 
be entered. 

Project ID This is the project designation for the specific project being 
performed under the contract. You must type the project code in 
EXACTLY as it is issued; otherwise your data may not be filed 
properly. 

Type Mix The GDOT Mix designation for the mix being tested. This must 
be a valid mix code selected from the dropdown list. 

Level The level of the mix if applicable. Select one: N/A, A, B, C or 
D. 

Lot No The lot number of the mix being tested. Only positive integer 
numeric values are valid in this field. Letters and symbols are 
not allowed.  

4. Click the Create/Edit button.  The DOT 159 Asphaltic Concrete Lot Worksheet will 
open. Notice the header information from the Create/Edit screen is populated on the top 
row of the window. 

 
Button Description 
Create/Edit If you entered values for all fields you will be taken to the record if it 

exists. If it does not, a new one is created automatically.  
Note: When using this method new blank records are immediately 
created and stored. To remove this record you must delete it.  
If you left one or more fields blank and more than one record matching 
the entered values is found, you will be prompted to select a record 
from a list. 

Search All Clicking this brings up a list of all records you have entered. This is the 
same as if you left all of the prompted fields blank and clicked 
create/edit. 

Open All Opens the data entry form but lets you work with all records at once 
instead of just one at a time. You may browse all of the records using 
the navigation buttons at the bottom of the entry form. This also allows 
you to use the “find” option on the form and apply your own filters.  

Cancel Returns you to the main menu. 
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FIGURE 1 - ASPHALTIC CONCRETE LOT WORKSHEET 

5. Enter all data as completely and accurately as possible. 
Note:  Quantity this lot (Tons) is entered by the technician and is used for plant ratings 
and other summary reports.  The Daily Tonnage Total Quantity: field adds up the daily 
tonnages.  This field can be a cross-check that the Quantity for this Lot is correct. 

Because of the large number of fields on this form, the form in broken up in to multiple 
pages which can be selected by clicking on the appropriate tab. This form was opened just as 
a sample. 
With the exception of the 640, 641, and OMR-049, which are continuous forms (that is you 
can see more than one record at a time), you must specify which record you wish to enter. 
Note: If you created a new record, some fields will be filled in automatically with the values 
from the last form of that type that you edited. 
6. Click the Tests tab. 
7. Click the Samples tab. 
8. Click the Pay Factors tab.  Note:  There is a checkbox for Correct and Ready to Send. 
9. Click the First Page button to return to the Header tab. 
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4.1.1 Form features 
This is an example of a generic data entry form. 
 
 

 
 
 
Note:  If the field on the form has a border, you can add data.  If the field does not 
have a border, it is considered a calculated field and is generated by the FDCS 
system based on your input in either fields on previous windows or other fields on 
the form. 

 Feature Description 
1 Selection Bar Clicking this selects records for copying or pasting. 
2 Title Bar You can drag this to move the window. 
3 Minimize Click here to make the form smaller. 
4 Maximize Click here to make the form bigger. 
5 Close & 

Save Data 
Click here to close the form and automatically save the 
data you entered. 

6 Scroll Bars If the form is too big to fit in the window you can use the 
scroll bar. 

7 Resize  If the window is too small you can drag this to make it 
larger. 

8 Total  Displays the total number of records.  
9 New  Creates or moves to a new record.  
10 Last  Takes you to the last record for the form selected. 
11 Next  Takes you to the record after the one displayed on the 

form. 
12 Display Area Shows the record number you are currently viewing. 
13 Previous  Takes you to the record before the one displayed on the 

form. 

2 

3 

4 5 

6 

7 8 

9 

10 

11 

12 13 14 

1 
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 Feature Description 
14 First  Takes you to the first record of the form selected. 
 
Click the Close button. 

 
4.2 Additional Forms 

 
4.2.1 Form 553 – Roadway Compaction form 

 

  
4.2.2 Random Number Sampling Utility 
The Asphaltic Concrete Random Sampling Utility is a utility that generates 
random asphaltic concrete load numbers.  This feature stores all generated records 
in the FDCS Client database. This is done so that previous lists may be recalled 
should the need arise.   Please note that once a random sampling list is generated 
you can not go back and make changes to the record.    
Note: These records are not uploaded to the FDCS Server. 
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To create a list of random load numbers:  
1. Click the Random Number Sampling Utility button.  The Random Sampling 

Utility window opens. 

 
2. Enter the following information: 
• Plant No.: 123 
• Project ID: STP-123(11)01 
• Type Mix: 19mm 
• Level: A 
• Lot No.: 01 
These will be the only fields you may edit when you start.   
3. Click Create>Edit.  The other fields are now enable and available for you to enter 

data. 
4. Fill in the remainder of the fields. A description of each field appears in the help bar 

at the bottom of the window.  However, you must maximize the window to view the 
descriptions. 

5. Check your data to make sure it is correct and then click Calculate. This will make 
the data you have entered permanent. A list of load numbers will appear in the output 
box at the right of the window, and the Print button will now be enabled. 

6. Click the Print button to open the print preview window. 
7. Select File >Print from the menu bar to print the report.  
8. If you want to start another record, click New.   
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4.2.3 Generic Random Number Generator  
 

 
This utility generates random numbers for tests that use random sampling.   To 
use this utility, do the following: 
1. In the Generate random numbers between …and fields, enter the range in 

which you want to generate these numbers (the range is inclusive). 
2. In the Increment of: field, enter the numeric increment to use. 
3. Click Calculate. This generates a list of 35 numbers (the amount that will fit 

on one printed page).  
4. Click Print Sheet if you wish to print the list of random numbers.  The Print 

Preview window opens to display the list of numbers. 
5. Select File >Print from the menu bar to print the report. 
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  What You Will Learn…. 
• How to Run a Report 
• How to Print a Report 
• How to Save a Report 
• How to Email a Report 
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5 Generating Reports in FDCS Client Software 
This chapter describes how users can generate asphalt reports from the FDCS 
client. Three types of reports are available from within the client software:  
Asphalt Summary, Aggregate Summary and each Test Record.  

5.1 Generating Asphalt Summary Reports from FDCS 
When you click the Asphalt Reports and Printouts button on the Roadway 
+ Plant tab from the main menu, the following window opens: 

 
From here you may generate the following asphaltic concrete reports: 
Report Name Report Description 
New Asphalt Plant Rating The asphalt plant rating system was 

developed using the Mixture Control 
Tolerances established in Section 828 of 
Georgia’s Standard Specifications. Uses 
the data from all of the entered 159 
Asphalt Concrete Lot Worksheets within 
the specified time range to generate a 
rating for a specified plant. Requires three 
samples per product code to be rated. 
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Report Name Report Description 
Asphalt Plant Rating Probation Same as above, but there is no minimum 

number of samples needed to generate a 
score.  

Asphalt Tonnage Report A report of all tonnage from all 159s 
within the specified time range. 

IPD and PCT Voids Report A statistical report of in-place densities 
and percent voids for each asphaltic 
concrete mix. 

Gradation Report A statistical breakdown of gradations for 
each asphaltic concrete mix. 

Lots Summary Report A summary report of Asphalt Lots per 
Contract ID 

List of all projects entered by users Produces a list of unique project codes 
gathered from all entered 159 reports. This 
helps identify incorrectly typed project 
codes. 

 
5.1.1 Lots Summary Report 

1. Click the Lots Summary Report button. The DOT 159 Lot Summary 
Report window opens. 

 
 
2. In the Contract ID field, enter B12345-00-000-0 
3. Click Get Details.   

Note:  You might receive an error that states, No Record Found. Error 1. 
Click OK to return to the Lots Summary Report window. 
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4. Click Print or Email File to save or share the report. 
Note: Each Type Mix is grouped and a Total Quantity for each mix is 
calculated. The Lots are listed in numeric order, making it easier to notice 
missing Lots or missing compaction data.  

 
5. Click Close.  You are returned to the Asphalt Report. 
6. Close the Asphalt Reports window. 
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5.2 Printing or E-mailing Reports 

 
When you click the Print button on the form, a preview window for the selected 
report opens.  This preview may be printed, e-mailed, or saved to a folder on your 
desktop, a diskette or a folder on the network.   
Note:  Be sure and create the folder before you create the report.  To create a 
folder on the desktop (right click your mouse, select new, select folder, rename 
the folder). 

5.2.1 To Print a Report 
To print a hardcopy report if you are attached to a printer: 
Note: This example will create a sub-folder in the windows default 
desktop folder. 

 
1. From the Main menu select File>Print. 

 
2. When the print dialog box appears click OK.  
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5.2.2 To e-mail a Report 
To e-mail the report: 
1. From the Main menu, select File>Send as Document.  Your email 

application should automatically open with the file as an 
attachment. 
Note: This is a generic document format recognized by most Word 
Processing Software. 

 
2. Select your profile and click OK. Your report will appear in the 

email as an attachment. 
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Note: Using this method you can only send one report. You must 
send the e-mail before you continue with any other program. 

 
5.2.3 Alternate Method to Send a Report 

 
Note:  This applies to the Lot Summary Report only. 

 

 
3. After generating the report, click Email File button. 
4. Right click on the file with the report name. 
5. Select Send To> Mail Recipient. 
6. Choose Outlook as the mail profile. 
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7. Enter the e-mail addressee and click Send to deliver your message. 
 

5.3 Saving a Report to a Folder on Your Computer 
1. On the Main menu, select File>Output to Document. 

 

 
 

2. Select the folder where you wish to save the report, then click OK. 
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Note: Be sure to add the Rich Text Format (.rtf) extension on the file. This 
file type preserves the special formatting and header information in the test 
report. If you try to save the report using any other format extension it 
rearranges the data within the test report.  
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5.4 To e-mail a group of reports 
To email more than one report at a time it is recommended that you save all 
the reports to one folder on your computer. Then create an e-mail message and 
insert all the reports into the message as follows. 
1. Open your email program.  
2. Create a new message.  
3. Use the Insert menu option to select and include multiple report files in 

your email message. 
4. Address and Send the message. 
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6 Uploading to the GDOT External Web Server 
Test data uploaded to the web server is copied through secure GDOT network 
lines into the main GDOT Field Data database. Only authorized personnel can 
verify test data once it has been uploaded to the database server. Users of the 
Field Data Collection System Web Upload must have an Account ID, Password, 
and Technician Code. Please contact the District Testing Management Operations 
Supervisor, OMR Pit & Quarry Branch Chief, OMR Concrete Branch Chief, or 
OMR Bituminous Paving Branch Chief to have an account set up. 
 

6.1 Web Upload Process 
To perform this process, you must be connected to the internet through 
Virtual Private Network (VPN) or your Internet Service Provider (ISP).  
Also, you will need to obtain login credentials (user name and password) 
as provided by your company computer administrator.  Once you have 
your login information and are connected to the internet, follow the steps 
detailed below to upload your information.   

 
1. Connect to your Internet Service Provider. 

Note: For GDOT personnel, this means you should be logged on to the 
GDOT network.  

2. From the main FDCS menu, click the Upload Data to GDOT button in 
the lower left hand corner.  
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3. The start screen options window opens. 

 
4. Enter your Account ID, Password, and Tech(nician)Code.   
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5. Verify the Upload Files option (lower left) is selected.   
6. Click the Login button.  The Data Upload Page opens. 

 

 
7. Simultaneously press the [Ctrl] and [v] keys to select test records 

marked ‘Ready to Send’ and create a file to be uploaded.  
Note: DO NOT click the Browse button. The [Ctrl]+[v] step creates the 
package of records to be sent to the central database. 
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8. Once the file is listed in the Data Upload window, click the Submit 

Now! button. 
9. The Data Upload Page opens when the process is complete. This 

window may include error messages for any record that failed to upload. 
See the Troubleshooting section for an explanation of typical error 
messages and corrective action. 
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6.2 Retrieve Password 
Web Upload users can retrieve their Account ID and Password if that 
information has been lost or forgotten. 
1. To use this feature, starting at the Upload login menu, click the log in 

button.  The log in screen opens. 

 
 

2. Click the Retrieve Password button.  The password retrieval screen 
opens. 
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3. Ensure the cursor is in place and enter your email address. 
4. Click Send Password. An e-mail from the Georgia DOT Solutions 

Center will be sent to your email address. It will contain your Account 
ID and Password information from an FDCS Auto-Generated Mail 
program. 

6.3 Update Account information  
Note: Each user must ensure an accurate e-mail address is listed for them. 
Your email address will be used if you ever need to retrieve your password, 
so it is critical that your email address is correct. 
1. Connect to your internet provider. 

Note: For GDOT personnel, this means you should be logged on to the 
GDOT network.  

2. Open FDCS, if not already in use. 
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3. Click Web Upload button.   

 
4. Enter your Account ID, Password, and Tech(nician)Code. 

Note: The default password for new accounts is NICEDAY. 
5. Select the UPDATE ACCOUNT radio button (lower right). 
6. Click the Login button. 
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7. Check your user account to make sure it is correct. 
• Change your password from NICEDAY (using up to 10 characters). 
• Enter your correct telephone number. 
• Enter a correct and accurate e-mail address. This will be used if you 

ever need to retrieve your password, so it is critical the email 
address is correct. 

 
8. Click the Update Account button to save the changes to your 

information. 
9. Exit the user account update. 
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6.4 View Log 
If the user wants to see a log of the files uploaded, click the View Log 
button in the Update Account area.   
1. Click the View Log button. After a short delay, the Log Page opens.  
2. The panel on the left displays the log of files uploaded to the server. 
3. The panel on the right is the list of the batch run that uploads data from 

the external web server to the internal server to be verified by GDOT 
personnel. 
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7 Using the Backup/Restore Utility 
The Field Data Collection Software backup/restore utility program enables users 
to back up or restore data that has been saved to a diskette, hard drive or to a 
network computer or server. This utility can be used to backup test reports and 
transfer the file to another user so that another user can restore the data on their 
computer. This chapter provides a description of what is provided by the 
Backup/Restore Data utility in FDCS.  
 

7.1 Backing Up Data 
1. From the main menu, click the Backup/Restore 4.x Data button. The 
FDCS Backup window opens. 

 

   
2. Click the Start button to begin the backup/restore process. The 
Transaction Mode screen opens: 
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7.1.1 Database Backup – New Backup 
1. On the Transaction Mode window, click the Database 

Backup   option. 
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2. Click the Next button, which will take you to the backup 
options screen opens: 

  
 

3. Select the New Backup option and click the Next button. 
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4. Enter the backup file name ‘new.’ 
Note: In the Your Full Name Is: field, the system will add the 
date and file extension ‘.bkp’ 
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5. Click Next. 

  
6. In area 1.Select Drive field, select the C:\ drive. 
7. In area 2. Double-click to select the directory area, double click 

the FDCS folder. 
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8. Verify the folder by viewing it in This is the location you 
chose: and click the Next button.  The reports selection screen 
opens. 

  
9. Click the Select All Sections button. 
10. Click the Next button. 
Note: You can either select all (to select all types of reports) by 
clicking the Select All button beneath the corresponding reports or 
you could select a single ‘type’ of report. 
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11. Do one of the following: 
• To back up all files: 

a. Click the Back up all option if your wish to backup all 
files.  A confirmation message displays. 

 
b. Click Yes.  You are returned to the previous window.  

Messages will display at the bottom of the window to 
confirm the data backup. 

• To back up specific files: 
a. Click the Let Me Choose option if your wish to 

customize the backup. 
b. Click Next. 
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c. In the Project No.: field, enter “STP-123(11)01.” 
d. Click the Next button.  The confirmation window 

opens. 

  
e. Click Yes. 

 
f. Click the Exit button to return to the Main Menu. 
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7.1.2 Database Backup – Append 
1. From the main menu, click the New Backup/Restore Data 

button.  
2. On the transaction mode screen, select the Database Backup 

option. 

  
3. Click the Next button, which will take you to the backup 

options window opens. 
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4. Select the Append to Existing Backup option and click the 

Next button. The file location window opens. 

  
5. In area 1 select the C:\ drive. 
6. In area 2 double click the FDCS folder. 
7. In area 3 double click your file (in this example 

‘sample021804.bkp’ is the file). 
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8. Verify the contents of the lower This is the file you selected 
area and click the Next button.  The reports selection window 
opens. 

  
9. Click the Select All Sections button. 
10. Click the Next button. 
Note: You can either select all of a type of report (by clicking the 
Select All button beneath the corresponding reports) or select 
individual report types. 
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11. Click Back up all. 
12. Click Next.  
13. Click the Exit button to return to the Main Menu.   

7.2 Database Restore 
FDCS users are encouraged to utilize the Restore process detailed in the 
section that follows. Completing the Database Restore process is very 
similar to the Database Backup process detailed in the previous section.  
Note: The newest of all files will be used. For example, if you are restoring 
to a file that was created, 9/15/04 with a file dated, 10/15/04, the 9/15/04 file 
will be overwritten. The 9/15/04 file will be completely erased. Therefore 
before restoring save any FDCS data you wish to keep by copying it to a test 
folder (create a test folder by clicking file-new) then copy your data before 
restoring. 

 

1. From the main menu, click the Backup/Restore 4.x Data button.  The 
FDCS Backup window opens. 
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2. Click the Start button to begin the restore process.  The transaction mode 
window opens. 

  
3. Click the Database Restore button and click the Next button.  The file 
location window opens. 
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4. In the “1. Select or enter location:” field, select C:\FDCS 
5. In area “2.” select the folder where the file resides (remember you are 
appending or adding this backup to a backup that is already present).   
6. Finally, double click the file you wish to restore (we are appending to the 
sample021804.bkp file in this example) 
7. Verify “This is the file you selected:” and click the Next button.  The 
Report Restore Selection window opens. 
Note: If you ordinarily restore data from your ‘A:’ drive and you do not 
have a diskette in that drive, you may see the following error message.  
Click the OK button.   
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8. Click the Select All Sections button. 
9. Click the Next button, which will bring you to the restore customization 
window. 

 
10. Click Restore All. 
11. Click Next. 

Note: The user can either backup all or choose which ones to back up.  The Let 
me choose options are shown in section 5.1.1, Backup-New Backup. 
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1. Click the Next button.  The final restore verification window opens, 

confirming the restoration.  
 
*********Read the following carefully******** 

 
 

2. Click Yes.  The Process Complete window opens. 
 

 
 

3. Click Exit to return to the main menu. 
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8 FDCS Server View 
FDCS Server is the central database for test data collected on GDOT projects or at 
producer’s Quality Control labs and Uploaded from the FDCS Client. The 
Terminal Services function allows GDOT personnel to quickly view central 
database information through “FDCS Server Read-only”.  For most GDOT 
personnel this is the link to use for test record review. Please note that the data 
cannot be changed when using this link.  
  
OMR Testing Management supervisors (TMOS) and Technical Services 
Engineers (TSE) have special permissions to update and verify (authorize) FDCS 
test records Uploaded to the central database. Contact the Branch Chief or 
Supervisor to get “FDCS Server Production” permission established and the link 
installed on their computer. Users who do not have the necessary permission will 
receive an error message. 
8.1 Install FDCS Server link 
To install terminal services, do the following: 
1. On the Desktop, double click on My Computer 
2. Go to 

\\gdot.ad.local\gdot\Construction\Materials_Research\Systems\Install\FieldData.   
3. Select the FDCS Server Read-Only icon. This is an .rdp file. 
4. Drag and drop this link to your Desktop for future use. 
5. Exit My Computer. 
 
To open FDCS Server Read-only: 
1. Double click on the FDCS Server Read-Only icon on the Desktop. 
2. Click Ok.  The Logon window opens. 
3. Enter your GDOT network User name and Password,  
4. Click Ok.  The Read Only Field Data Database opens.   
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On the Main Menu, users have the ability to filter records for a single District 
only, rather than viewing all records statewide. The four tabs available are: 

• Unverified Data – a filtered view uploaded data for test records that 
have not been Verified (authorized) by OMR personnel. 

• Browse Data – all data that has been uploaded to the central database. 
• Reports – Asphalt, Aggregate, Cement, and other Materials Summary 

reports for all producer and technician submitted test records. 
• Gauge – View, Edit, and Print functions for Nuclear Gauge calibration 

functions. ‘Create Nuclear Gauge File’ and ‘Update Gauge Factors 
from Update Disk’ are active in FDCS Server Production and are not 
available in FDCS Server Read-only. (This topic is covered in the 
FDCS Admin class.) 
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8.2 Unverified Data 
The Unverified Data tab on the Main Menu includes links to each of the forms in 
FDCS. When the user clicks on a button, the form view opens with the only the 
test records that have not been Verified (authorized) by a TMOS or TSE. This is a 
tool to bring the newly submitted test records to their attention, rather than 
searching through all records to find those that need authorization. 
To open an Unverified test record: 
1. On the FDCS Server Main Menu, click the Unverified Data tab. 
2. Click the DOT 159 button.  The DOT 159 form window opens. This is the 

same form that is seen on the FDCS Client. 
3. Click the Next Record button at the bottom of the form. Notice that the 

number of records is filtered; this indicates the number of records waiting to 
be authorized. 

4. Close the DOT 159 window to return to the Main Menu.   
 

8.2.1 View Upload Logs 
On the Unverified Data tab, the View Upload Log button will connect the 
user to the Upload Log on the FDCS Upload Site. This allows GDOT 
personnel to verify when uploads were made by producers and 
technicians. The Upload Log includes date, time, and status information 
for all upload attempts; status includes the user ID and any success or 
error message generated as part of the upload. This window also includes 
a record of when Upload user accounts are created or updated. 
To review the log of uploaded test records: 
1. On the Unverified Data tab, click the View Upload Logs button. 
Note: It may take a minute or more for the Upload Log to display. Be 
patient. 
2. Click the scroll bar on the upper zone to review the log of test records 

uploaded.   
3. Click the scroll bar on the lower zone to review the log of user 

accounts updated.   
4. Close the Upload Log window to return to the Main Menu.   
 

8.3 Browse Data 
The Browse Data tab on the Main Menu includes links to each of the forms in 
FDCS. Users have two options – Open and Find.  
When the user clicks on the Open button, the form view opens with all those 
test records in the central database. This includes all Unverified records.  
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When the user clicks on the Find button, a window with selection parameters 
gives the opportunity to filter the records to only those that meet the criteria. 
Notice in the upper zone ‘Find by key information’ that more than one criteria 
can be entered. For instance, if Plant Number “123” and Type Mix “12.5mm” 
are both entered then only the records that match both criteria will be shown 
in the form view. 
To find a recent test record for a contract/project: 

 
1. On the FDCS Server Main Menu, click the Browse Data tab. 
2. Click the DOT 159 Find button.  The Find DOT 159 window opens.  
3. In the Contract ID field, type T00000-00-000-0 
4. Click the Find button under the Contract ID field. 
5. The DOT 159 form window opens. This is the same form that is seen 

on the FDCS Client. 
6. Click the Last Record button at the bottom of the form. Notice that 

the number of records is filtered; this indicates the number of records 
for the criteria selected. 

7. On the Menu bar, click View\Datasheet View. The window switches 
from a form view to a table view of the test records. 

8. Click in the Date field. 
9. On the Menu bar, click Sort\Sort Descending. This will sort the 

records to show the most recent test records at the top of the table. 
10. Click in the Type Mix field. 
11. On the Menu bar, click Filter\Filter by Selection. Notice that this 

limits the records shown to just those for the type of asphalt selected in 
step 10. 

12. On the Menu bar, click View\Form View. The window switches from 
a table view to the familiar form view of the test records, including the 
Print button. 

13. Close the DOT 159 window to return to the Main Menu. 
Note: Filter and Sort can be done when in Form view as well as in Datasheet 
view. Datasheet view simply shows multiple records at the same time. Find, 
Filter, and Sort can be used for any field selected in the test records. 
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8.4 Reports 
There are multiple reports available for FDCS Server.  Click the Reports tab 
to view these report options. 
• Asphalt Plant Rating Reports include the following: 

Report Name Report Description 
Asphalt Plant Rating The asphalt plant rating system was 

developed using the Mixture Control 
Tolerances established in Section 828 of 
Georgia’s Standard Specifications. Uses 
the data from all of the entered 159 
Asphalt Concrete Lot Worksheets within 
the specified time range to generate a 
rating for a specified plant. Requires three 
samples per product code to be rated. 

Asphalt Plant Rating Probation Same as above, but there is no minimum 
number of samples needed to generate a 
score.  

Asphalt Tonnage Report A report of all tonnage from all 159s 
within the specified time range. 

IPD and PCT Voids Report A statistical report of in-place densities 
and percent voids for each asphaltic 
concrete mix. 

Gradation Report A statistical breakdown of gradations for 
each asphaltic concrete mix. 

Lots Summary Report A summary report of Asphalt Lots per 
Contract ID 

# of Reports per Asphalt Plant Count of DOT 159 records per plant for 
the date range entered. 

# of Reports per Plant by District Count of DOT 159 records per plant for 
the date range entered, sorted by District 
number. 

Statewide Average JMF Deviations Averages, Standard Deviation, and 
number of Sample per sieve sizes, sorted 
by Type Mix. 

List of all projects entered by users Produces a list of unique project codes 
gathered from all entered 159 reports. This 
helps identify incorrectly typed project 
codes. 

• Aggregate Reports include Quarry Rating reports and Aggregate test 
record Summary reports. 

• Portland Cement Reports include selection criteria for Mill Code, 
From/To date ranges, or Material Type. All criteria are optional for 
limiting the records shown on the report. It is recommended that at 
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least one criteria be entered, and multiple criteria can be used when 
generating a report. 

• Materials Summary Reports include selection criteria for Material Test 
Type (by form number), From/To date ranges, Contract ID, or 
Technician ID. The Material Test Type is required, but the other 
criteria are optional for limiting the records shown on the report. 
Notice that multiple criteria can be used when generating a report. 

 
To generate a test record report for a contract/project: 
 

1. On the FDCS Server Main Menu, click the Reports tab. 
2. Click the Asphalt Plant Ratings button. 
3. Click the Lots Summary Report button. The DOT 159 Lot Summary 

Report window opens. 

 
4. In the Contract ID field, enter T00000-00-000-0 
5. Click Get Details.   

Note:  You might receive an error that states, No Record Found. Error 
1. Just click OK. 
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6. The Lots Summary report opens. 

Note: Each Type Mix is grouped and a Total Quantity for each mix is 
calculated. The Lots are listed in numeric order, making it easier to 
notice missing Lots or missing compaction data.  
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8.4.1 Printing Reports from FDCS Server 
1. From the Main Menu, select File>Print. 

 
2. When the print dialog box appears click OK.  

 
 
8.4.2 Saving Reports from FDCS Server 
Terminal Services acts a remote desktop to help speed the access to the 
data in FDCS Server. This also means the user in not on their own Profile 
on the computer with all the connections to their e-mail account. 
Therefore, in order to share the results of a report with people who do not 
have access to FDCS Server, the report must first be saved. 
To save a report to a folder: 
1. In an open report, on the File menu, select Output to Document. 
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2. Select the network folder where you wish to save the report, then click 

OK. 
Note: It is recommended that you Save in: a mapped network drive such 
as a personal share or the OMR directory (Q:\). 
Note: Be sure to use the rtf extension on the file. The Rich Text Format 
(RTF) preserves the special formatting and header information in the test 
report. If you try to save the report using any other format extension it 
rearranges the data within the test report.  
3. Click Close.  You are returned to the Asphalt Plant Rating window. 
4. Close the window to return to the FDCS Server Main Menu. 

 
8.4.3 E-mailing Reports from FDCS Server 
Do NOT use the EMAIL button or File\Send to Recipient to send FDCS 
Server reports to others. See 8.4.2 for more information on saving reports 
so they can be shared with people who do not have access to FDCS 
Server. 
To email reports saved from FDCS Server it is recommended that you 
save all the reports to one folder on your computer. Then create an e-mail 
message and insert the reports into the message. 
To e-mail FDCS reports as attachments: 
1. Open your email program.  
2. Create a new message.  
3. Use the Insert menu to select and include saved FDCS report files in 

your email message. 
4. Address and Send the message. 
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  What You Will Learn…. 
• Request FDCS Webview 

Account 
• Login Webview 
• Navigate in Webview 
• Generate reports 
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9 Webview Account 
Field Data Collection System Webview was established to give producers and 
contractors a portal to see their data on the central database once they have 
submitted quality control data to GDOT. Producers and contractors have secure 
login accounts to ensure that they can review their own data and ONLY their own 
data. Once an account is established for a plant, the plant personnel have the 
ability to maintain their account information, including changing the password.  
 
To establish a FDCS Webview account, an approved Asphalt producer or Cement 
producer who will be Uploading data to GDOT should submit the following 
required information to the Technical Services Engineer who is their point of 
contact:  
• Plant or mill name and number 
• Name of point of contact at plant 
• Phone number 
• Plant e-mail address 
• Desired password 
 
Note: FDCS Read-only and FDCS Webview are both a non-editable view of the 
same FDCS central database. These are not copies of the central database. 
GDOT personnel who use FDCS Read-only can see the data for all plants. 
Producers who use FDCS Webview can see the data for only their own plant. 
Technical Services Engineers may also have a Webview account to see the same 
view as producers for confirmation purposes, but should primarily use FDCS 
Read-only to review data and run reports. 

9.1 Logging In to Webview 
The plant name and number will be used as the account ID for FDCS 
Webview. For instance, when Acme Asphalt establishes an account for 
approved plant number 99, the account ID would be “AcmeAsphalt099”. The 
plant e-mail address will be used by the Retrieve Password feature to send the 
account ID and current password to the plant personnel. 

 
The login site for FDCS Webview can be found at https://gdot-web2/fdcsw/ 

 
A link to the address can also be found at the OMR Software webpage at 
http://www.dot.state.ga.us/dot/construction/materials-research/software.shtml 

 
For the purpose of training, we will be using a Training FDCS Webview 
website with a fictional asphalt plant. 
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To login to a Webview account: 

1. Double-click on the FDCS Training Webview shortcut on your 
desktop. 

2. The FDCS Secure Login window opens. 

  
3. In the User ID field, type Training123 and press the [Tab] key.   

Note:  Account IDs and passwords are case sensitive and must be 
typed exactly. If the password is incorrect, the user has a chance to 
retrieve the password by clicking on “Forgot Password?” Based on the 
plant information, the account ID and password will be sent to the 
plant e-mail account. If the plant e-mail address is incorrect, this will 
not work as designed. 
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4. In the Password field, type Pass and press the [Enter] key. The 
FDCS Webview window opens.  
Note: The fictional Asphalt Plant no. “123” is shown and is not 
editable. 

  
9.2 Navigating in Webview 
Depending on the type of material produced by a plant, FDCS Webview will 
open with a view of the following forms: 
• Asphalt forms DOT 159 and DOT 150 along with standard asphalt plant 

rating reports shown in FDCS Client.  
• Cement form OMR-049 and the standard cement report shown in FDCS 

Client.  
Another feature of FDCS Webview is the link between related DOT 159 and 
DOT 150 test records. The link is based on Plant No., Type Mix, Lot No., 
Date, and Contract ID. All five fields must match exactly in order for the 
records to be linked. 
All plants have the ability to update their own user account information, with 
the exception of the Account ID (the unique identifier). 
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9.3 Reviewing Uploaded Test Records 
The exercises in this section are a continuation of the previous exercise (Login 
to Webview), and show records for a fictional asphalt plant. 

 
To open asphalt forms: 
1. On the FDCS Webview window, click the DOT 150 button. The DOT 150 

form view opens. 
2. Click the Search button in the upper left corner of the window. The search 

parameters window opens. 

 
3. In the Contract ID field, enter T00000-00-000-0 and click the Find button. 
4. Click the Last Record button at the bottom left corner of the window. 

Note the number of records displayed to the right. 
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 5. Close the DOT 150 form. 
6. Click the DOT 159 button. The DOT 159 form view opens. 

 7. Click the Search button in the upper left corner of the screen. The search 
parameters window opens. 
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 8. In the Contract ID field, enter “T00000-00-000-0” and click the Find 
button. 

9. Click the Last Record button at the bottom left corner of the screen. Note 
the number of records. 

10. In the bottom center of the screen, does the note indicate a related DOT 
150 has been found?  Do the following: 

a. If yes, click the DOT 150 button in the upper right corner of the 
window. The DOT 150 form opens. 

b. Click the DOT 159 button in the upper right corner of the window 
to return. 

11. Close the DOT 159 form. 
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9.4 Updating Your Webview Account 
As previously mentioned, plants may wish to update the Webview account as 
information changes. For instance, a new contact person at the plant may need a 
new password, or the e-mail address may change. 
Note: Be sure to notify other plant personnel who have permission to use the 
account when the password is changed. If the plant has difficulty with the 
Webview Account, contact the GDOT Technical Services Engineer for assistance. 
To update account information: 

1. On the FDCS Webview window, click the User Account button. The 
Account Information window opens. 

 
2. In the Contact Info field, enter your own name. 
3. Click the Update Account button. 
4. Click Back to Main to return to the Webview Main Window. 
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9.5 Webview Reports 
Asphalt reports and Cement reports in FDCS Webview are much the same as 
the reports found in the FDCS Client. The main difference is that many 
months/years of reporting are available, and the test records must be Verified 
(authorized) by GDOT personnel before they are included in rating reports. 
Note: The Asphalt Plant Rating report includes only the DOT 159s that have 
been verified by GDOT supervisory personnel. The report also requires a 
minimum of three verified DOT 159s to calculate the rating. See GDT 107 for 
more information on how the plant rating is calculated. 
To generate Asphalt reports: 
1. On the FDCS Webview Main Menu, click the Monthly Summary 

Report button. The selection window opens. 
2. Select the Month “June” from the dropdown list. 
3. Select the Year “2005” from the dropdown list. 
4. Click the Get Details button. The report window opens. 
5. Use the scroll bar on the right edge of the window to see the report page 

for each mix type. 
6. Click the Print button. The print dialogue window opens. 
7. Select the printer and click OK. 

Note: A printer must be set up for the local computer. Webview does not 
include printer settings. 

8. Click the Close button to close the report window.  
9. On the FDCS Webview Main Menu, click the Yearly Summary Report 

button. The selection window opens. 
10. Select the Start Date Month “July” and Year “2004” from the dropdown 

lists. 
11. Select the End Date Month “June” and Year “2005”from the dropdown 

lists. 
Note: The user can select any range of dates. Select the same month and 
year for Start and End dates, and the user should get the same rating 
results as the Monthly Summary Report.  

12. Click the Get Details button. The report window opens. 
13. Use the scroll bar on the right edge of the window to see the report page 

with each month and a final summary. 
14. Click the Close button. 
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The reports in Webview can not be saved, and FDCS Webview does not 
include an automatic connection to the user’s e-mail account. Therefore, 
contact the Technical Services Engineer or TMOS if there is a problem with 
the Monthly or Yearly Summary Report. 

 
9.6 Summary Exercise 
1. Who should use a Webview account? 
2. What information is required to set up a Webview account? 
3. What should you do if you forget the password? 
4. Can you navigate between related forms? Which forms? 
5. What should you do to share a report with someone? 
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  What You Will Learn…. 
• Specific Form Tips 
• Installation Tips 
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10 Tips and Tricks 
 
The following sections provide tips and workarounds that address specific forms and 
functionality in FDCS: 
 

10.1 General 
• DO NOT USE COMMAS in any field on any form. This will cause errors when 

uploading. 
• Be careful to use the number zero (0), not the letter oh (O) when entering Contract 

IDs and Project numbers. 
 

10.2 Random Sampling Number Utility 
• Run this program once per Lot to receive random load numbers for each sublot. 

See GDT 73 for information on random sampling numbers. 
• If you need to generate the numbers more than once, get approval from the 

Technical Services Engineer. 
 

10.3 Nuclear Gauge Factors 
• Update your gauge factors in the Client from diskette whenever the gauge is 

calibrated.  
• See your TMOS or Assistant for the diskette. They can copy it from the server 

site. 
• Refresh your gauge factors in the DOT150 and DOT553 form by unselecting and 

then re-selecting your gauge number to update the factors. 
 

10.4 159 Form 
• Contracts with multiple project numbers – use the lead project number as shown 

on the contract. 
• Airport projects without Contract ID# - use 000000-00-000-0. 
• Delete a sample record by selecting the bar on the far left side of the form and 

using the Delete key. 
• Linked to related DOT 150 in Server 
• Header information & Date must match 
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10.5 150 Form 
• Populate correction factor fields. 
• Do not mix gauge and core results – these are two separate rows. 
• On the Server, linked to related DOT 159 with matching information. 
10.6 553 Form 
• Populate correction factor fields. 
• Select “Other (Specify)” in the Item Description field for materials not on list 
• Enter the specifics in the Extended Description field. Ex: “Shoulder” 

 
10.7 Aggregates 
• Use the aggregate import format described in the TechDocs at: 

http://www.dot.state.ga.us/dot/construction/materials-research/software.shtml 
• When ready to import, save the aggregate file to C:\Program 

Files\GDOTDCS\Import 
• Always delete files from Import folder after import process is completed. 

 
10.8 Portland Cement 
• Use the Portland Cement template and process described in the TechDocs at: 

http://www.dot.state.ga.us/dot/construction/materials-research/software.shtml 
• When ready to import, save the aggregate file to C:\Program 

Files\GDOTDCS\PCImport 
• Always delete files from PCImport folder after import process is completed. 

 
10.9 Uploading 
• Just “pop” the Ctrl+V keys when preparing to Submit a package. Holding the 

keys down too long will result in a very long file name and the Upload will fail. 
• You can try again after deleting the file name. 
• IF you had errors in your Upload, click No when you get this message as you 

close the Upload page. It will prevent the records that weren’t uploaded from 
being marked as Sent.  

• Then you don’t have to un-check and re-check the records as Ready to Send. 
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10.10 Backup/Restore 
• Backup your data to diskette or a server share weekly, after you have Uploaded 

the records. 
• If you Backup files before uploading them, when you Restore the files they are 

NOT marked as ‘Sent’ and will be submitted again with your next upload. You 
may get an error message that the record has already been received and is 
verified. 

• Make a full Backup of your data prior to installing an upgrade. 
• When you get a new computer, make a full Backup of your data from the old 

computer and then Restore it on the new computer. 
• For a new computer, you will need to do the Full Install of FDCS prior to 

Restoring. 
 

10.11 Installation 
• The latest version of FDCS can be found at: 

http://tomcat2.dot.state.ga.us/fdcs/upgrade/fdcsupgrade2.cfm 
• OPEN AND READ THE “INSTALL INSTRUCTIONS” BEFORE 

DOWNLOADING THE APPLICATION! 
• Save the application to your Desktop, do NOT Run the install from the website. 
• FDCS Client must be closed BEFORE you run the installation program.  
• If you navigate to the upgrade website from the globe button in the Client, 

remember to close the Client. 
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  What You Will Learn…. 
 
How to resolve issues with 
FDCS functionality not 
addressed in the Tips and 
Tricks chapter 
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11 Troubleshooting 
The following sections address problems and resolutions to FDCS functionality. 

11.1 Installation 
FDCS Upgrade and Full Installation packages are at 
http://tomcat2.dot.state.ga.us/fdcs/upgrade/fdcsupgrade2.cfm 

 
Error 
Upgrade link shows “Webpage can not be displayed.” 
Resolution 
Are you connected to the Internet? 
If no, contact your Internet Service Provider. If yes, contact the GDOT Solution Center at 
404-651-5010. 
Common questions: 
• Did you read the Install Instructions? 
• See the upgrade webpage. 
• Did you save the download file to your Desktop? 
• Do not Run the download file from the internet. The installation will not be 

completed successfully. 
• Did you close the FDCS Client before running the Upgrade installation? 
• The upgrade won’t work if the database is open. 
• Did you wait for each component of the install to finish and click OK at each step? 
• Some Clients have many records and the database upgrade may take several (10+) 

minutes. Closing the install program prematurely may cause loss of test reports. 
• Do you have admin or power user permissions on your computer? 
• Some companies have tight security that will only allow someone from IT Support to 

install applications. 
• What error message did you receive 
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11.2 Uploading 
Error 
What’s My Password? 
Resolution 
Use the Retrieve Password function. An e-mail will be sent with your User ID and 
password to the mailbox. 
If you are a new user, contact the Technical Service Engineer for your plant, Testing 
Management Operations Supervisor, or Assistant TMOS to have an account set up. 
 

11.3 Upload File Error 
 
Error Message 
The MIME type of the uploaded file "application/octet-stream" was not accepted by 
the server.  
Only files of type "text/plain" can be uploaded.  
Verify that you are uploading a file of the appropriate type. Upload aborted. Please 
correct the error and try again. 
Resolution 
The file name is too long, probably because the Ctrl+V keys were held down.  
Correction: 

1. Click Upload on the navigation bar.  
2. Delete the file name.  
3. Hold down the Ctrl key and quickly tap the V key on your keyboard. The file 

name will appear in the field. 
4. Click Submit Now! 

 
11.4 Files Already Uploaded and Verified 

 
Sample Error Text 
Upload from eregister failed. Cause:Error - Record DOT150 has already been 
verified. (Look into the report where PlantNo = xxx and ProjNo = 'PR000-S007-
00(314)C1' and TypMix = '25mm SP' and MixLevel = 'A' and LotNo = '1'.) 
Resolution 
The file was previously uploaded to the Server and verified by a GDOT supervisor.  
Correction:  
If you need to replace the record: 

1. Close the Upload page. 
2. Click No for “Was the Upload successful?” 
3. Call the TSE or TMOS to have the record Un-verified. 
4. Try to Upload again. 

If this was a mistake: 
1. Close the Upload page. 
2. Click Yes for “Was the Upload successful?” The record will be marked as Sent. 
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11.5 Records have a comma 
 

Sample Error 
Upload from ERSnell81 failed. Cause:Error: File Type Not Recognized: BUT HAD 
OVEN PROBLEMS. TALKED TO OVEN MAN AND MADE ADJUSTMENTS. 
Resolution 
The file had a comma in it, usually in front of the text shown in the error message. These 
are usually in the Remarks field, but can be in any field. All records in the queue after the 
one with the comma will not be uploaded.  
Correction: 

1. Close the Upload page. 
2. Click No for “Was the Upload successful?” 
3. Open the record you think had the error.  
4. Find and remove the comma. 
5. Uncheck and re-check ‘Ready to Send.”  
6. Try to Upload again. 

 
11.6 Support 
Contact the Solutions Center at 404-651-5010 or 1-800-651-5010. 
Use the support instructions at http://www.dot.state.ga.us/dot/construction/materials-
research/downloads/fdcs-index.shtml 

 
11.7 How to capture and send a screenshot 
1. While the problem or error message appears on your screen, press ALT+PrtScn 

(or on some laptops FN+PrtScn) on your keyboard.  
2. Put your cursor in the  Technical Support Request form, and click the Paste 

button. This will paste a graphic image of your screen in the document.) 
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